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sehari

BABII
TINJAUAN PUSTAKA DAN LANDASAN TEORI

TINJAUAN PUSTAKA

Feberapa studi mengenai pengontrolan peralatan listrik pada kehidupan

- hari merupakan permasalahan yang menarik untuk dicari alternatif

penyelesaiannya. Berikut ini penelitian — penelitian yang sebelumnya dilakukan

seputar|| pengontrolan peralatan listrik. “Alat Pengukur dan Pembatas Dalam

Pemutusan Listrik Menggunakan Remote Control Berbasi Mikrokontoler

AT89S51” (Agung Syahputra 2009).

Secara

“Perancangan dan Pembuatan remote control Lampu dan Elektronika

Wirless tf Berbasis Mikrokontoler PIC” (Viky Surya Abadi 2010).

“Penggunaan Teknologi Java Pada Sistem Pengendali Peralatan Elektronika

Melalui| Bluetooth” (David Fajar Hermawan, etal 2011). “Alat Pengontrol

Pcralata}n Listrik Mengunakan remote TV Berbasis Mikrokontoler AT89C51”

(Eko Putro Lasmono, et al. 2009).

|

[
Untuk mengoptimalkan fungsi dan pentingnya kepraktisan serta efesiensi

dari remote control TV, maka dalam skripsi ini dibuat sistem pengontrol intensitas

cahaya ..;ampu pijar yang mengunakan remote control sebagai pengendalinya.

}
i
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2.2

2.2.1.

|I)ASAR TEORI

'lllnfra Merah (Infrared)

Gambar 2.1 gambar macam-macam infrared

Infra merah (infra red) ialah sinar elektromagnet yang panjang

geloml:[uangnya lebih daripada cahaya nampak yaitu di antara 700 nm dan 1 mm.

Sinar infra merah merupakan cahaya yang tidak tampak. Jika dilihat dengan

dengaﬂ spektroskop cahaya maka radiasi cahaya infra merah akan nampak pada
!

spectrim elektromagnet dengan panjang gelombang di atas panjang gelombang

cahaya merah. Dengan panjang gelombang ini maka cahaya infra merah ini akan

tidak

tampak oleh mata namun radiasi panas yang ditimbulkannya masih

terasa/dideteksi. Infra merah dapat dibedakan menjadi tiga daerah yakni:

Nea[r Infra Merah.................. 0.75-1.5 pm
Mid Infra Merah............c..... 1.50 - 10 pm
FaJ‘Infra 1 — 10 - 100 pum




Infra Merah sebenarnya cahaya normal dengan warna tertentu. Kita tidak

bisa melihat warna ini karena panjang gelombang 950 nm nya di bawah spektrum

cahaya tampak. Itulah salah satu alasan mengapa IR dipilih untuk tujuan remote

control, kita ingin menggunakannya, tapi kita tidak tertarik melihatnya.

‘Efleskipun kita tidak dapat melihat cahaya Infra Merah yang dipancarkan
dari re

1ote control bukan berarti kita tidak dapat membuatnya terlihat. Sebuah

kameraljvideo atau kamera foto digital dapat membuat kita melihat cahaya Infra

Merah.

iCukup arahkan remote ke kamera tersebut, tekan sembarang tombol maka

kita akan melibat kedipan LED Infra Merah. Matahari adalah sumber cahaya dan

memancar cahaya infra merah. Beberapa sumber cahaya lain misal bola lampu,

lilin, sumber pemanas dan bahkan tubuh kita memancarkan cahaya Infra Merah

serta s:!_gala sesuatu yang memancarkan panas juga memancarkan cahaya Infra

Merah!

|

|
‘Oleh karena itu harus diambil beberapa tindakan sebagai pencegahan

|
untuk menjamin bahwa pesan IR yang akan dikirim ke penerima tidak mengalami

error iiikarenakan banyak sumber cahaya infra merah disekitar kita sehingga

memp

engaruhi data yang dikirim melalui Remote Control Infra Merah.

 Tindakan yang dilakukan untuk mencegah pengaruh cahaya infra merah

dari s

imber lain beberapa vendor menggunakan protokol komunikasi data untuk

Remote Control Infra Merah yakni dengan cara memodulasi dengan frekuensi

tertent

u pada data dijital (berbentuk kedipan) sehingga dengan menset protokol




yang sama antara Transmitter dan Receiver maka sumber cahaya infra merah yang

lain tidak dapat mempengaruhi data yang dikirim.

2.2.2

banyal‘;iI

yang @

Metode Pengiriman Data Remote Control
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Gambar 2.2 nifrared kit

;Remate control banyak kita jumpai dipasaran. Biasanya bdigunakan untuk
hal di televisi, sound sistem, TV tunner, dan lain- lain. Langkah pertama

i ketahui adalah mengetahui protokol dari pengiriman sinyal dari remote

remot

cantro(q tersebut. Berikut penulis sertakan taham mengeset atau memprogram

kit ke Arduino :

1. R Kit itu sendiri terdiri dari Infrared Receiver, kabel dan Remote
Control dengan 21 tombol. Gambar 2.2.

2. IR Receiver mempunyai 3 pin untuk dihubungkan ke Arduino Uno,

yaitu pin VCC ke pin 5V Arduino, pin GND ke pin GND Arduino
dan pin D ke salah satu pin Digital Arduino (contohnya

menggunakan pin Digital 11). Gunakan kabel yang sudah disediakan
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di dalam paket IR Kit dan 3 buah kabel jumper untuk
menghubungkannya ke Arduino
Apabila koneksi seperti di atas sudah dilakukan, sekarang kita coba
kode program untuk membaca/menerima sinyal InfraRed dan
menampilkannya lewat Serial Monitor.
Tulis program dibawah di Arduino
/*
* JRremote: IRrecvDemo - demonstrates receiving IR codes with IRrecv
* An IR detector/demodulator must be connected to the input RECV_PIN.
* Version 0.1 July, 2009
* Copyright 2009 Ken Shirriff

* http://arcfn.com
*/

OO ~1 O\ N

9 #include <IRremote.h>

10

11int RECV_PIN =11;

12

131Rrecv irrecv(RECV_PIN);

14

15decode_results results;

16

17void setup()

18{

19 Serial.begin(9600);

20 irrecv.enableIRIn(); // Start the receiver
21}

22

23void loop() {

24 if (irrecv.decode(&results)) {

25 Serial.printin(results.value, HEX);
26 irrecv.resume(); // Receive the next value
27 }

28}

11
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ubungkan board Arduino anda dengan kabel USB ke komputer. Di
Arduino IDE, klik menu Sketch>Verify / Compile untuk melakukan
kompilasi dan memastikan tidak ada error pada kode program
tersebut. Klik menu File>Upload untuk memasukkan program
tersebut ke dalam board Arduino anda. Kemudian buka Serial
Monitor dari menu Tools>Serial Monitor, sesuaikan baudrate-nya
dengan yang ada di dalam kode program.

Ok, saatnya mencoba remote yang disediakan bersama dengan IR Kit
ini. Arahkan remote ke IR Receiver dan tekan salah satu tombol
remote tersebut, lalu perhatikan Serial Monitor. Di sana nanti akan
muncul kode dari tombol remote yang kita tekan. Coba lagi untuk

tombol-tombol yang lain. Tampilan output di Serial Monitor kurang

lebih seperti gambar 2.3

12



(© ReecvDemo | Arduino 103
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Gambar 2.3 Gambar pengesetan IR kit

|
':?. Selesai

l
2.2.3 |Sekilas Arduino Uno

lArduino Uno adalah salah satu produk yang berlebel arduino yang

sebenarnya adalah suatu papan elektronik yang mengandung mikrokontroller

ATmega328 (sebuah keping yang secara fungsional bertindak seperti sebuah
I

kompuiter). piranti ini dapat dimanfaatkan untuk mewujudkan rangkaian

elektronik dari yang sederhana hingga yang kompleks. pengendalian led hingga

pengontrolan robot dapat diimplementasikan dengan menggunakan sebuah

arduino.

13




4

Arduino uno mengandung microprosesor berupa ATmel AVR dan di

lengkapi dengan oscillator 16mhz yang memungkinkan operasi berbasis waktu

dilaksanakan dengan tepat, dan regulator ( pembangkit tegangan) 5volt. sejumlah

pin tersedia di papan, pin 0 hingga pin 13 digunakan untuk isyarat digitalyang

bernilai

10 dan 1. pan A0-AS5 digunakan untuk isyarat analog. Arduino uno

dilengk ipi denga static random acces memory (SRAM) berukuran 2kb untung

memegang data, flash memory berukuran 32kb, dan erasable programble read-

only me

:mory (EEPROM) untuk menyimpan program

!
¥Uno” berarti satu yang diambil dari bahasa Italia dan penggunaan nama

ini untuk menandai peluncuran Arduino 1.0. Uno dan versi 1.0 akan menjadi versi

|
b

referensi Arduino, yang akan terus berkembang. Uno adalah yang terbaru dalam

serangk'aian papan USB Arduino, dan digunakan sebagai model referensi untuk

platform Arduino.
I

I
]

Adapun data teknis board Arduino UNO R3 adalah sebagai berikut :

Mikrokontroler : ATMEGA328

Tegangan Operasi : 5V

Tegangan Input (recommended) : 7- 12V
Tegangan Input (limit) : 6-20 V

Pin digital 1/0 : 14 (6 diantaranya pin PWM)
Pin Analog input : 6

Arus DC per pin /O : 40 mA

Arus DC untuk pin 3.3 V : 50 mA

14



¢ Flash Memory : 32 KB dengan 0.5KB digunakan untuk bootloader
e SRAM:2KB
¢ EEPROM:1KB

¢ Kecepatan Pewaktuan : 16 MHz

ntruksi- intruksi dalam memori program dieksekusi dalam satu alur
tunggal)l dimana pada saat satu intruksi dikerjakan intruksi berikutnya sudah
diambill| dari memori program. Konsep inilah yang memungkinkan intruksi —
intruksilidapat dieksekusi dalam setiap satu siklus clock. 32 x 8-bit register serba
guna digunakan untuk mendukung operasi apada ALU (Aritmatic Logic Unit)
yang dapat dilakukan dalam satu siklus. 6 dari register serbaguna ini dapat
digunakan sebagai register pointer -16bit pada mode pengalamatan tak langsung
untuk mengambil data pada pada ruang memori data . ketiga pointer 16-bit ini di
sebut dei:ngan register X (gabungan R26 dan R27), register Y (gabungan R28 dan
R29), nl:agister Z (gabungan R30 dan 31). Hampir semua intruksi AVR memiliki
format iﬁ-bit . setiap ala,at program terdiri dari intruksi 16-bit atau 32-bit. Selain
register; serba guna di atas terdapat register lain yang terpetakan dengan teknik

memory mapped 1/O selebar 64 byte.

15




Gambar 2.4 Tampilan depan arduino
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Gambar 2.5 Tampilan belakang Arduino
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Gambar 2.6 Skema board arduino uno

(https://klyx.files.wordpress.com/2012/09/arduino600x464.jpg?w=595)

Tabel 2.1 Deskripsi Arduino Uno
| Mikrokontroler ATmega328
Tegangan pengoperasian 5V
Tegangan input yang disarankan 7-12v
~ Batas tegangan input 6-20V
i Jumlah pin I/O digital 14 (6 di antaranya menyediakan keluaran
PWM)
Jumlah pin input analog 6
| Arus DC tiap pin I/O 20 mA
| Arus DC untuk pin 3.3V 50 mA
\

Memori Flash

32 KB (ATmega328), sekitar 0.5 KB digunakan
oleh bootloader

, SRAM 2 KB (ATmega328)
| EEPROM 1 KB (ATmega328)
| Clock Speed 16 MHz

17



2.2.3.1 Arsitektur ATMega 328

ATMega328 keluaran dari atme! yang mempunyai arsitektur RISC (Reduce

(hbtlp:

r

Intruction Set Computer) yang dimana setiap proses eksekusidatanya
daripada arsitektur CISC (Completed Intruction Set Computer). Dibawah ini
i

gambar arsitektur, dan block diagram ATMega328.

8-bit Data Bus
L 4
Program Status
Flash Counter * and Control
Program
Nemory
Interrupt
h 4 > 32x8 <> Unit
Instruction General =
Register Purpose i 3P|
4—1 FRegistrers P Unit
F
Instruction Watlchd
Decoder y J = Tumerog
2 g N
v 8 g ALY | Analog
Contro! Lines = § = Comparalor
< b
g g
6 E <« 1,0 Modulel
Data <«—sle—> 10 Modute 2
SRAM
<—»{ [/OModulen
EEPROM <+
IO Lines <P
Gambar 2.7 Arsitektur ATMega328

/12.bp blogspot.com/_rVKRbUv6N3Q/TRIJO_ISnMI/AAAAAAAAACA/OmATwAo0s

bE/s1600/atmega.png)
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Gambar 2.8 Block Diagram ATMega328

(http://upvector.com/atmega/atmegal 68_pdip_block.png)
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2.23.2

Konfugurasi Pin ATMega328

Daya Board Arduino Uno

Arduino UNO dapat disuplai melalui koneksi USB atau dengan

sebuah power suplai eksternal. Sumber daya dipilih secara otomatis.

' Suplai eksternal (non-USB) dapat diperoleh dari sebuah adaptor
|
AC ke DC atau battery. Adaptor dapat dihubungkan dengan mencolokkan

sebuah center-positive plug yang panjangnya 2,1 mm ke power jack dari

board. Kabel lead dari sebuah battery dapat dimasukkan dalam

}Jeaderfkepala pin Ground (Gnd) dan pin Vin dari konektor POWER.

Board Arduino UNO dapat beroperasi pada sebuah suplai eksternal
6/ sampai 20 Volt. Jika disuplai dengan yang lebih kecil dari 7 V, kiranya

pin 5§ Volt mungkin mensuplai kecil dari 5 Volt dan board Arduino UNO

c.l

isa menjadi tidak stabil. Jika menggunakan suplai yang lebih dari besar

[—y

2 Volt, voltage regulator bisa kelebihan panas dan membahayakan board

I
Arduino UNO. Range yang direkomendasikan adalah 7 sampai 12 Volt.

|
in-pin dayanya adalah sebagai berikut:

o~}

e[| VIN. Tegangan input ke Arduino board ketika board sedang
menggunakan sumber suplai eksternal (seperti 5 Volt dari koneksi
. USB atau sumber tenaga lainnya yang diatur). Kita dapat menyuplai

tegangan melalui pin ini, atau jika penyuplaian tegangan melalui

power jack, aksesnya melalui pin ini.

20




b.

e 5V. Pin output ini merupakan tegangan 5 Volt yang diatur dari
regulator pada board. Board dapat disuplai dengan salah satu suplai
dari DC power jack (7-12V), USB connector (5V), atau pin VIN dari
board (7-12). Penyuplaian tegangan melalui pin 5V atau 3,3V
membypass regulator, dan dapat membahayakan board. Hal itu tidak

dianjurkan.

¢ 13V3. Sebuah suplai 3,3 Volt dihasilkan oleh regulator pada board.

Arus maksimum yang dapat dilalui adalah 50 mA.
¢ GND. Pin ground
Memori

ATmega328 mempunyai 32 KB (dengan 0,5 KB digunakan untuk
bootloader). ATmega 328 juga mempunyai 2 KB SRAM dan 1 KB
ﬁI?EPROM (yang dapat dibaca dan ditulis (RW/read and written) dengan

I
EEPROM library).
|
[Iinput dan Output

Setiap 14 pin digital pada Arduino Uno dapat digunakan sebagai
input dan output, menggunakan fungsi pin Mode(), digital Write(), dan
Higital Read(). Fungsi-fungsi tersebut beroperasi di tegangan 5 Volt.
Setiap pin dapat memberikan atau menerima suatu arus maksimum 40 mA
dan mempunyai sebuah resistor pull-up (terputus secara default) 20-50

kOhm. Selain itu, beberapa pin mempunyai fungsi-Serial:

1

21




Al
setiapn

Secara

0 (RX) dan 1 (TX). Digunakan untuk menerima (RX) dan
memancarkan (TX) serial data TTL (Transistor-Transistor Logic).
Kedua pin ini dihubungkan ke pin-pin yang sesuai dari chip Serial

Atmega8U2 USB-ke-TTL.

External Interrupts: 2 dan 3. Pin-pin ini dapat dikonfigurasikan
untuk dipicu sebuah interrupt (gangguan) pada sebuah nilai rendah,
suatu kenaikan atau penurunan yang besar, atau suatu perubahan

nilai. Lihat fungsi attach Interrupt untuk lebih jelasnya.

PWM: 3, 5, 6, 9, 10, dan 11. Memberikan 8-bit PWM output

dengan fungsi analog Write.

SPI: 10 (SS), 11 (MOSI), 12 (MISO), 13 (SCK). Pin-pin ini

mensupport komunikasi SPI menggunakan SPI library.

LED: 13. Ada sebuah LED yang terpasang, terhubung ke pin
digital 13. Ketika pin bemilai HIGH LED menyala, ketika pin

bernilai LOW LED mati.

'lduino UNO mempunyai 6 input analog, diberi label AO sampai A5,
ya memberikan 10 bit resolusi (contohnya 1024 nilai yang berbeda).

default, 6 input analog tersebut mengukur dari ground sampai tegangan 5

Volt, ¢1engan itu mungkin untuk mengganti batas atas dari rangenya dengan

mengg

mempu

unakan pin AREF dan fungsi analogReference(). Di sisi lain, beberapa pin

yai fungsi spesial:
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TWI: pin A4 atau SDA dan pin A5 atau SCL. Mensupport komunikasi

TWI dengan menggunakan Wire library

. AREF. Referensi tegangan untuk input analog. Digunakan dengan

| analogReference().

} Reset. Membawa saluran ini LOW untuk mereset mikrokontroler.

Secara khusus, digunakan untuk menambahkan sebuah tombol reset
untuk melindungi yang memblock sesuatu pada board.

Pemograman

Arduino UNO dapat diprogram dengan software Arduino. Pilih

“Arduino Uno dari menu Tools > Board (termasuk mikrokontroler pada

board). Untuk lebih jelas, lihat referensi dan tutorial.

ATmega328 pada Arduino Uno hadir dengan sebuah bootloader
yang memungkinkan kita untuk mengupload kode baru ke ATmega328
tanpa menggunakan pemrogram hardware eksternal. ATmega328
berkomunikasi menggunakan protokol STK500 asli (referensi, file C

header).

Kita juga dapat membypass bootloader dan program

| mikrokontroler melalui  kepala/header 1CSP  (In-Cirouit ~ Serial

Programming); lihat instruksi untuk lebih jelas.
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Sumber kode firmware ATmegal6U2 (atau 8U2 pada board revisi
1 dan revisi 2) tersedia. ATmegal6U2/8U2 diload dengan sebuah

bootloader DFU, yang dapat diaktifkan dengan:

: Pada board Revisi 1: Dengan menghubungkan jumper solder pada

I
belakang board (dekat peta Italy) dan kemudian mereset 8U2.

Pada board Revisi 2 atau setelahnya: Ada sebuah resistor yang
menarik garis HWB 8U2/16U2 ke ground, dengan itu dapat lebih mudah
untuk meletakkan ke dalam mode DFU. Kita dapat menggunakan software
Atmel’s FLIP (Windows) atau pemrogram DFU (Mac OS X dan Linux)
untuk meload sebuah firmware baru. Atau kita dapat menggunakan header
ISP dengan sebuah pemrogram eksternal (mengoverwrite bootloader

DFU). Lihat tutorial user-contributed ini untuk informasi selengkapnya.

(PCINTA4RESET) PCs O 1 28 [1 PGS (ADCS'SCUPCINT13)
{PCINT16RXD) PDO (]2 27 [ PC4 (ADCU/SDAPCINTIZ)
(PCINT17/TXD) PD1 {3 26 ] PC3 (ADCAPCINT11)
(PCINT18INTO) PD2 O] 4 251 PC2 (ADCYPCRIT10)

(PCINT19:0C2BNT1) FD3 5 243 PC1 {ADGUPCINTY)

(PCINT20/XCK/T0) PD4 []6 23[1 PCO (ADCA/PCINTS)

voc 7 22 GND
GHp 8 21 [JAREF
(PCINTE/XTALI/TOSC1) PB6 (]9 201 AvCC
{PCINTZ/XTAL2TOSC2) PB7 190 PB5 {(SCK/PCINTS)
(PCINT21/0C0B/T1) PDS 18[00 PB4 MISOPCINTS)
(PCINT220COA/AING) PDS 17 |1 P83 MOSIOC2APCINTS)
(PCINT23/AINT) PD7 161 PB2 SSOCIBPCINT)
(PCINTQICLKOACP1) PBO |5J:| PB1 (OC1A/PCINT1}

Gambar 2.9 Konfigurasi Pin ATMega328

(https://fandiajiputra.files.wordpress.com/2013/04/ssssddd.png
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ATMega328 memiliki 3 buah PORT utama yaitu PORTB,

I[’ORTC, dan PORTD dengan total pin input/output sebanyak 23 pin.
IgORT tersebut dapat difungsikan sebagai input/output digital atau
difungsikan sebagai periperal lainnya.

1. Port B

Port B merupakan jalur data 8 bit yang dapat difungsikan sebagai

input/output. Selain itu PORTB juga dapat memiliki fungsi alternatif

e

o

seperti di bawah ini.

e ICP1 (PB0), berfungsi sebagai Timer Counter 1 input capture pin.

e OCIA (PB1), OCIB (PB2) dan OC2 (PB3) dapat difungsikan
sebagai keluaran PWM (Pulse Width Modulation).

e MOSI (PB3), MISO (PB4), SCK (PBS5), SS (PB2) merupakan jalur

komunikasi SPI.

‘ e Selain itu pin ini juga berfungsi sebagai jalur pemograman serial
(ISP).

e TOSC1 (PB6) dan TOSC2 (PB7) dapat difungsikan sebagai
sumber clock external untuk timer.

e XTAL1 (PB6) dan XTAL2 (PB7) merupakan sumber clock utama

mikrokontroler.

D. Port C

Port C merupakan jalur data 7 bit yang dapat difungsikan sebagai

input/output digital. Fungsi alternatif PORTC antara lain sebagai berikut.

25




3.
|
|
|

|

ADC6 channel (PCO,PC1,PC2,PC3,PC4,PC5) dengan resolusi
sebesar 10 bit. ADC dapat kita gunakan untuk mengubah input
yang berupa tegangan analog menjadi data digital.

I2C (SDA dan SDL) merupakan salah satu fitur yang terdapat pada
PORTC. I12C digunakan untuk komunikasi dengan sensor atau
device lain yang memiliki komunikasi data tipe I2C seperti sensor
kompas, accelerometer nunchuck.

Port D

Port D merupakan jalur data 8 bit yang masing-masing pin-nya
j}flga dapat difungsikan sebagai input/output. Sama seperti Port B dan Port
lLTI,', Port D juga memiliki fungsi alternatif dibawah ini.

e USART (TXD dan RXD) merupakan jalur data komunikasi

serial dengan level sinyal TTL. Pin TXD berfungsi untuk
mengirimkan data serial, sedangkan RXD kebalikannya yaitu
sebagai pin yang berfungsi untuk menerima data serial.

Interrupt (INTO dan INT1) merupakan pin dengan fungsi
khusus sebagai interupsi hardware. Interupsi biasanya
digunakan sebagai selaan dari program, misalkan pada saat
program berjalan kemudian terjadi interupsi hardware/software
maka program utama akan berhenti dan akan menjalankan

program interupsi.
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224

empat |

e XCK dapat difungsikan sebagai sumber clock external untuk
USART, namun kita juga dapat memanfaatkan clock dari CPU,
sehingga tidak perlu membutuhkan external clock.

'. e TO dan T1 berfungsi sebagai masukan counter external untuk
timer 1 dan timer 0.

e AINO dan AINI keduanya merupakan masukan inpuf untuk

analog comparator.

Triac BTA4160

Triac merupakan komponen semikonduktor yang tersusun atas diode

apis berstruktur p-n-p-n dengan tiga p-n junction. Triac memiliki tiga buah

elektrode, yaitu : gate, MT1, MT2. Triac biasanya digunakan sebagai pengendali

dua arah (bi-directional). Apabila kita akan menggunakan triac dalam pembuatan

I
perangi:hat atau sistem kontrol elektronik, ada beberapa hal yang harus diketahui

dalam Il

breako !

\emilih triac sebagai berikut.

|
|Hal-Hal Yang Perlu Diperhatikan Dalam Memilih Triac : tegangan

yer maju dan mundur arus maksimum ( IT maks) arus genggam minimum

(Th min) tegangan dan arus picu gate yang diperlukan kecepatan pensaklaran

tegange

n maksimum dV/dt tegangan blocking triac (VDRM).
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‘| Gambar 2.10 Simbol dan bentuk Triac
||Triac akan tersambung (on) ketika berada di quadran I yaitu saat arus
positif’ kecil melewati terminal gate ke MT1,dan polaritas MT2 lebih tinggi dari
MT]1, |'saat triac terhubung dan rangkaian gate tidak memegang kendali, maka triac
tetap flcrsambung selama polaritas MT2 tetap lebih tinggi dari MT1 dan arus yang
menga!llir lebih besar dari arus genggamnya (holding current/Ih), dan triac juga
akan lersambung saat arus negatif melewati terminal gate ke MT1,dan polaritas
MT1 |lebih tinggi dari MT2, dan triac akan tetap terhubung walaupun rangkaian
gate tidak memegang kendali selama polaritas MT1 lebih tinggi dari MT2. Selain
dengan cara memberi pemicuan melalui teminal gate, triac juga dapat dibuat
tersambung (on) dengan cara memberikan tegangan yang tinggi sehingga

|
melampaui tegangan breakover-nya terhadap terminal MT1 dan MT2, namun cara

ini tidak diizinkan karena dapat menyebabkan triac akan rusak. Pada saat triac
i

28




tersambung (on) maka tegangan jatuh maju antara terminal MT1 dan MT2

sangatlah kecil yaitu berkisar antara 0.5 volt sampai dengan 2 volt.

225

Optocoupler MOC3021

b

Gambar 2.11 Optocoupler MOC3021

Optocoupler adalah merupakan komponen yang berpungsi untuk mengatur

|

feedback yang masuk ke STR/T ransistor/IC Power dibagian power supply.

Optocoupler ini juga beberapa dalam proses star up TV serta berpungsi

juga sebagai penyesuaian tegangan output power supply switching. Tapi banyak

yang tidak tahu bagaimana cara kerja optocoupler ini, terutamayang baru

menger.:al yang namanya optocoupler.

|
Optocoupler adalah suatu piranti yang terdiri dari 2 bagian yaitu

transmitter dan receiver, yaitu antara bagian cahaya degan bagian deteksi sumber

cahaya

it'stpisah. Biasanya optocoupler digunakan sebagai saklar elektrik yang

t
!

bekerja'secara otomatis.

Optocoupler adalah suatu komponen penghubung yang bekerja berdasarkan

picu cahaya optic.
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Optocoupler terdiri dari dua bagian.

pada transmitter dibangun dari sebuah LED infra merah. Jika

dibandingkan dengan menggunakan LED biasa, LED infra merah memiliki

ketahanjan yang lebi baik terhadap sinyal tampak. Cahaya yang dipancarkan oleh

LED inf:'ra merah tidak terlihat oleh mata telanjang.

Photo

pada bagian receiver dibangun dengan dasar komponen photodiode.

diode merupakan suatu transistor yang pekah terhadap cahaya. Suatu

sumbetl' cahaya menghasilkan energi panas,begitu pula dengan spektrum infra

I
merah|Karena spektrum infra menpunyai efek panas yang lebi besar dari cahaya

+

me
mac

sisi

I.mup&l,mﬂka photodiode lebih peka untuk menangkap radiasi dari sinar infra

Ditinjau dari kegunaan fisik optocoupler dapat berbentuk bermacam-

I. Bila hanya digunakan untuk mengisolasi level tegangan atau data pada

ansmitter dan sisi reseiver, maka optocoupler ini bisasanya dibuat dalam

bentu]lc solid (tidak ada ruang antara LED dan Photodiode). Sehingga sinyal listrik
|

yang fada pada input dan output akan terisolasi. Dengan kata lain optocoupler ini

di gjnakm sebagai optosilator jenis IC.

Prinsip kerja dari optocoupler adalah:

1. Jika antara photodiode dan LED terhalang maka photodiode tersebut

akan off sehingga output dari kolektor akan berlogika high.

2. sebaliknya jika antara photodiode dan LED tidak terhalang maka

photodiode tersebut akan on sehingga output-nya akan berlogika low.
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2.2.6

Resistor

Carbon Film on
Ceramic Tube

|
Nichrome

Wire

Gambar 2.12 Pengertian resistor

Resistor sering di sebut werstan, tahanan atau penghambat adalah suatu

komporllen elektronik yang dapa menghambat gerak lajunya arus listrik. Resisitor

di sin

kat dengan huruf “R” (huruf R besar). satuan resistor Adalah Ohm, yang

mene: Eukan adalah George Ohm(1787- 1854), seorang ahli fisika bangsa jerman.

Tahan'If\\ bagian dalam ini di namai konduktansi. Satuan konduktansi ditulis

dengar

II kebalikan dari Ohm yaitu mhol.

R_V
Tl

Di mana V adalah beda potensial antara kedua ujung benda penghambat I

adalak.‘ besar arus yang melalui benda penghambat, dan Radalah besaran hambat

benda I[penghambat tersebut.
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2.2.7 PCB lubang

Gambar 2.13 PCB lubang

]%agi anda hobbyist elektronika , pengetahuan membuat PCB adalah perlu

sebab w:alaupun merangkai sebuah proyek elektronika pada perforated PCB atau

PCB lubang/ bolong bisa di lakukan dengan cepat, tetapi untuk proyek yang
cukup besar, tugas sekolah atau proyek untuk di jual kepada klien tetap perlu PCB

yang rapi agar mudah trouble shootingnya dan terlihat lebih pro.

Printed Circuit Board (PCB) atau papan Rangkaian Tercerak adalah papan

rangkaian yang digunakan sebagai tempat penghubung jalur konduktor dan

penyusunan letak komponen — komponen elektronik yang dimaksud dengan jalur

konduktor adalah sistem pengkabelan komponen sebagai bagian dari hubungan

data dan kelistrikan pada komponen tersebut. Macam — macam bentuk PCB
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Matrix Strip Board (papan matrix bergaris) dan PCB Coper Clad (berlapis

tembaga).

22.8 Kabel

:[Zabel, media untuk mengantarkan arus listrik atau informasi. Bahan dari
kabel i

 beraneka ragam,khusus sebagai pengantar arus listrik, umumnya terbuat

dari tembangga dan umumnya di lapisi dengan pelindung. Selain tembaga, ada

juga kabel yang terbuat dari serat optik, yang di sebut dengan faiber optic cable.
Belum di masukingambar kabel Kabel ini merupakan jenis kabel fieksibel dengan
penghantar tembaga serabut berisolasi PVC. Di gunakan untuk instalasi panel

panel yang memerlukan fleksibelitas yang tinggi.
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